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Abstract

Dam besides having great benefits, also holds the potential dangers are great. The dam break can cause flooding which can result in a devastating
loss of life. The purpose of this study was to determine the extent of inundation that may occur as a result of dam break and determine the sensitiv-
ity of the flood peak discharge generated by dam break to breach parameter.Simulation modeling floods performed using HEC - RAS software
4.1.0. Analysis of the mean daily maximum rainfall areas conducted by the Thiessen Polygon method . Frequency agihan test results qualify the
Log Pearson Type I1I method . PMP DAS Pacal of 518,179 mnz . A flood discharge plan that meets the criteria in the chart Creager is a Syn-
thetic Unit Hydrograph method ( HSS ) Kanazawa with PMF at 2047,71 n/ Sec . Furthermore , the mapping flooding from overtapping col-
lapse nsing HEC - GeoRAS 3.4.93 software that diintregrasi in ArcGLS software version 9.3. The sensitivity analysis showed that the peak
Slood discharge (Qoutflow) generated by a dam break sensitive to changes in the parameters (b and ) and the coefficient of variation n manning.
Inundation maps analysis of the results shows flood affected areas of highest risk is Sukosewn village , subdistrict Kapas.

Keywords: Dam Break Analysis, PMF Discharge, Floodplain Mapping

Abstrak

Bendungan disamping memiliki manfaat yang besar, juga menyimpan potensi bahaya yang besar. Bendungan yang runtuh dapat
menimbulkan banjir dahsyat yang akan mengakibatkan banyak korban. Tujuan dari studi ini adalah mengetahui luasan genangan
yang mungkin terjadi akibat dari runtuhnya bendungan dan mengetahui sensitivitas debit puncak banjir yang dihasilkan oleh
keruntuhan bendungan terhadap parameter keruntuhan. Simulasi pemodelan banjir dilakukan menggunakan soffware HEC-RAS
4.1.0. Analisis hujan maksimum harian rerata daerah dilakukan dengan metode Polygon Thiessen. Hasil uji agihan frekuensi yang
memenuhi syarat yaitu Metode Log Pearson Type III. PMP DAS Pacal sebesar 518,179 mm. Debit banjir rancangan yang
memenuhi kriteria pada grafik Creager adalah metode Hidrograf Satuan Sintetik (HSS) Nakayasu dengan PMF sebesar 2047,71
m?/dt. Selanjutnya, dilakukan pemetaan banjir akibat keruntuhan overfgpping dengan menggunakan soffware HEC-GeoRAS 4.3.93
yang diintregrasi dalam soffware ArnGIS versi 9.3. Hasil analisis sensitivitas menunjukkan bahwa debit puncak banjir (Qoutflow) yang
dihasilkan oleh keruntuhan bendungan sensitive terhadap perubahan parameter keruntuhan (b dan z) dan variasi koefisien n
manning. Hasil analisis pemetaan genangan menunjukkan daerah yang terkena resiko banjir paling tinggi adalah desa Sukosewu,
kecamatan Kapas.

Kata Kunci : Keruntuhan Bendungan, Debit PMF, Peta Genangan.

PENDAHULUAN

Bendungan Pacal terletak di Desa Kedungsumber, Kecamatan Temayang, Bojonegoro, Provinsi Jawa Timur, berdaya
tampung air sekitar 23 juta m’ juga memiliki potensi runtuh. Bendungan Pacal adalah menyerupai jenis bendungan
urugan batu membran beton (bendungan UBM). Kekurangan pada bendungan urugan batu adalah lemahnya daya
tahan bendungan terhadap oversopping. Oleh karena itu, bendungan harus diimbangi dengan bangunan pelimpah yang
kapasitasnya mampu mengalirkan debit besar. Kejadian kemungkinan runtuhnya bendungan Pacal menarik untuk
dikaj.

Dari latar belakang di atas maka timbul beberapa perumusan masalah dalam studi ini, yaitu:
1. Bagaimana kemungkinan genangan akibat keruntuhan bendungan?
2. Bagaimana hasil simulasi hidrologi dan hidraulika akibat dam break?

TINJAUAN PUSTAKA DAN LANDASAN TEORI

Keruntuhan bendungan biasanya diawali dengan rekahan (breach) yang terbentuk pada tubuh bendungan. Rekahan
adalah bukaan yang terbentuk pada proses runtuhnya tubuh bendungan. Sebenarnya mekanisme tidak begitu dipahami
baik untuk bendungan urugan tanah maupun beton (Yanuar, 2012). Upaya sebelumnya pernah dilakukan peneliti yang
menganggap tubuh bendungan runtuh seluruhnya, serentak dan sesaat. Untuk meramal banjir di hilir akibat kerutuhan
bendungan, biasanya dianggap bendungan runtuh total dan mendadak (Fread, 1988 dalam Yanuar, 2012).

Pada skenario keruntuhan bendungan Evinos, Kotsovinos N.E. (1998) menyatakan bahwa ukuran, bentuk dan waktu
yang dibutuhkan untuk pengembangan keruntuhan tergantung pada erodibilitas material urugan dan karakteristik ali-
ran. Karakteristik keruntuhan yang diperlukan sebagai znput program DAMBRK yang digunakan adalah: 1) ukuran ter-
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tinggi dari lebar dasar keruntuhan, 2) elevasi tertinggi dari dasar keruntuhan, 3) bentuk keruntuhan, 4) waktu yang di-
perlukan untuk mengembangkan keruntuhan, dan 5) elevasi air permukaan waduk di mana keruntuhan dimulai.

Menurut Jeremy Franz (2010), empat elemen penting dari setiap analisis keruntuhan bendungan antara lain:
Pendugaan parameter keruntuhan (ukuran, bentuk dan waktu keruntuhan), 2) Keruntuhan debit puncak dan estimasi
hidrograf keruntuhan, 3) Keruntuhan penelusuran banjir, 4) Estimasi kondisi hidrolik di lokasi kritis.

Menurut Brad Newlin, PE (2007), Metode pendekatan keruntuhan bendungan meliputi: 1) Analisis hidrologi, meliputi:
penentuan Probable Maximum Precipitation (PMP), penentuan parameternya, dan mengkalibrasi dengan input hidrograf,
2) Detail keruntuhan bendungan, meliputi: ukuran, bentuk, tinggi dan waktu formasi keruntuhan dan prediksi
parameter keruntuhan, USBR(1998), 3) Penelusuran gelombang banjir (floodware), meliputi: penelusuran hidrologi dan
penelusuran hidraulika, 4) Pemetaan daerah tergenang (berbahaya).

Pada deskripsi rekahan oleh Freed (1988), parameter keruntuhan bendungan yang mempengaruhi sifat hidrograf banjir
di hilir bendungan terdiri atas durasi proses keruntuhan (t), lebar dasar bukaan bagian yang runtuh (b) dan kemiringan
lereng bentuk bukaan (z) seperti Gambar 1.

BENDUNGAN

Rekahan (breach) Keterangan:
/ ho = Tinggi rekahan bagian atas
ma ~ hb = Tinggi rekahan bagian bawah
””””” 1 oo hbm = Tinggi rekahan terendah bagian bawah
7777777777777 IJ z = Kemiringan lereng rekahan 1: z
ho b ' h h = Tinggi muka air

hb b = Lebar dasar rekahan

Foom R — b = Lebar dasar rekahan rerata

Sumber: Abinet Kutie Asrate, 2010
Gambarl. Model Proses Keruntuhan Bendungan

Nilai z tergantung pada sudut gesek material bendungan, dapat bernilai dari 0 sampai 1 atau lebih. Bentuk rekahan
keruntuhan tergantung pada kombinasi nilai b dan z. Jika b > 0 dan z > 0, maka bentuk rekahan keruntuhan adalah
trapesium. Jika b > 0 dan z = 0, maka bentuk rekahan keruntuhan adalah segi empat dan jika b = 0, z > 0, maka
bentuk rekahan keruntuhan segitiga. Parameter keruntuhan tersebut untuk mewakili rekahan sebagai ulasan yang
sederhana/umum, pemakaian luas, serta adanya ketidakpastian pada mekanisme rekahan yang sebenarnya (Freed, 1988
dalam Yanuar, 2012).

Peneclusuran banjir pada debit aliran melalui bangunan spilway (Qs) tergantung pada lebar bangunan spilway (B),
tinggi peluap (H) dan koefisien debit (C) = 1,7 — 2,2 m!/2/dt (diambil 2,2 m'/2/dt) dengan persamaan berikut:

QS = C B (H)3 2 1]
Saat terjadi overtopping aliran mengalir melalui spz/fway hanya sebatas lebar spillway, sehingga persamaan untuk debit
yang melebihi mercu bendungan (Qo) diuraikan sebagai berikut:

Qo =Qs+ C. (L1 + L) Hueorrri s sss s 2]
dengan:

Li, Ly = Panjang aliran yang melewati bendungan (m)

METODE PENELITIAN

Lokasi penelitian dilakukan di bendungan Pacal, Kabupaten Bojonegoro, Provinsi Jawa Timur. Data yang
digunakan meliputi: Peta Rupabumi (RBI) digital Bakosurtanal skala 1:25.000, data hujan harian tahun 1979 —
2010, gambar main dam Pacal. Alat bantu yang digunakan dalam penelitian ini, yaitu: soffware HEC-HMS 3.2 untuk
pengolahan data hidrologi, Hec-RAS 4.1 untuk pengolahan simulasi model keruntuhan bendungan, dan HEC-
GeoRAS 4.3.93 yang diintregrasi dalam software AreGILS 9.3 untuk pemetaan genangan.

HASIL DAN PEMBAHASAN

Analisis dan pengolahan hidrologi

1. Data hujan yang tersedia adalah data hujan harian dari stasiun penakar hujan Sukun, sta Gondang, sta Sugi-
han, dan sta Tretes yang diperoleh dari Balai Besar Wilayah Sungai Bengawan Solo. Data hujan harian yang
diperoleh dari ke-empat stasiun yaitu 32 tahun (1979 — 2010).

2. Uji kepanggahan data dilakukan dengan menggunakan lengkung massa ganda. Hasil uji konsistensi untuk
stasiun Tretes ditampilkan pada Gambar 2.
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Gambar 2. Grafik Uji Konsistensi Stasiun Tretes

Hasil uji kepanggahan data menunjukkan bahwa hujan konsisten dan data hujan pada setiap stasiun panggah.

3. Hujan maksimum harian rerata daerah dilakukan dengan metode Polygon Thiessen. Koefisien Thiessen diperoleh
dengan pembagian luasan DAS berdasarkan Polygon Thiessen.

4. Agihan frekuensi hujan dihitung dengan beberapa metode untuk menghitung besarnya hujan rancangan antara lain,
Metode Normal, Log Normal, E.J. Gumbel dan Log Pearson Type II1. Dari hasil perhitungan, maka dipilih agihan
yang memenuhi syarat adalah metode agihan Log Pearson III. Selanjutnya dilakukan wji ¢bi square dan smirnov-
kolmogoroy untuk menguji kecocokan agihan data apakah memenuhi syarat untuk perencanaan atau tidak. Dari hari
uji kecocokan agihan, maka agihan Log Pearson Type 111 dapat diterima.

5. Hujan Rencana dihitung dengan periode ulang tertentu dilakukan dengan metode Log Pearson Type III dan
metode isohyet. Kemudian kedua metode tersebut dibandingkan dan dipilih hasil yang terbesar. Dati perbandingan
dipilih hujan rencana dengan metode Isohyet.

6. Hujan Maksimum Boleh Jadi (Probable Maimum Precipitation-PMP) dihitung untuk DAS Pacal dihitung dengan me-
tode Isohyet dan statistical Hershfield, yang selanjutnya akan dibandingkan dan dipilih hasil yang terbesar. Hasil
perhitungan PMP, hujan terbesar yaitu 518,179 mm dengan metode Hershfield.

7. Intensitas Hujan Pola Agihan Hujan Jam-jaman untuk mendapatkan debit rancangan berdasarkan hujan rancan-
gan diperlukan data hujan jam-jaman. Berhubung data hujan jam-jaman tidak tersedia untuk wilayah penelitian,
maka hujan jam-jaman diturunkan dari hujan harian berdasarkan perkiraan lama hujan atau waktu konsentrasi
dengan membandingkan persamaan waktu konsentrasi metode Kirpich dan metode ARR (Awustralian Rainfall and
Runaff) yang kemudian dipilih nilai terbesar. Waktu konsentrasi yang digunakan yaitu metode ARR sebesar 4,1 jam
dan dibulatkan menjadi 4,0 jam. Penetapan hujan jam-jaman menggunakan persamaan intensitas hujan dengan
metode #zodifred Mononobe.

8. Debit Banjir Rancangan dalam analisis menggunakan 2 metode yaitu Hidrograf Satuan Sintetik (HSS) Nakayasu
dan Clark Unit Hydrograph, kemudian kedua metode tersebut dibandingkan dengan grafik Creager untuk
mendapatkan nilai debit banjir rancangan yang paling akurat. Hasil pengeplotan grafik Creager maka debit banjir
rancangan yang memenuhi dengan nilai debit terbesar yaitu Metode HSS Nakayasu sebesar 2047,71 m3/dt.

9. Penelusuran banjir bertujuan untuk mengetahui debit ozzflo maksimum dan tinggi air maksimum di hilir pelimpah.
Hidrograf banjir akibat keruntuhan bendungan disajikan pada Gambar 3. Hidrograf debit ouflow pada Gambar 3
lebih besar dari debit #flow karena merupakan hidrograf saat terjadi keruntuhan bendungan.
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Gambar 3. Grafik Hidrograf Banjir Q PMF

DEBIT ( m3/dt)

Analisis Hidraulika

1. Tampang lintang sungai
Pada setiap penampang sungai, HEC-RAS menggunakan beberapa parameter masukan untuk menggambat-
kan bentuk, elevasi, dan lokasi relatif sepanjang sungai. Input parameter simulasi keruntuhan bendungan
mengikuti data yang ada yaitu peta digital RBI Bakosurtanal, namun hal ini tidak mempengaruhi perbedaan
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pada hasil data perhitungan hidrologi dan hidraulika pada HEC-RAS. Untuk sisi hulu bendungan tidak
disimulasi karena simulasi keruntuhan bendungan mulai dati bendungan hingga hilir. Dikarenakan peta RBI
Bakosurtanal memiliki keterbatasan interval kontur sehingga batas hilir yang disimulasi hingga 40 km dari
bendungan. Hal ini disebabkan setelah km 40, kontur sungai berada pada elevasi yang relatif datar.
Bendungan Pacal

Data teknis bendungan Pacal yaitu: Tinggi bendungan = 35 m, elevasi mercu bendungan = + 117 m, dan panjang
bentang pada Pacal = 90 m.

Penentuan Nilai n manning

sungai alam berceruk, melapuk pada dasar sungai, kerikil dan sedikit tanaman mempunyai nilai n manning
0,02 untuk hulu. Sedangkan untuk hilir, saluran alam, tanah, berkelok-kelok, banyak tanaman pengganggu,
bertebing dan saluran tidak beraturan mempunyai nilai n manning 0,03 (Ven Te Chow, 1959).

Perkiraan Parameter Rekahan

1.
2
3.
4

5.

Bentuk rekahan, dalam studi ini diasumsikan rekahan berbentuk trapesium.

. Elevasi dasar rekahan (hb), diasumsikan menjadi sama dengan elevasi minimum bendungan yaitu 108 meter.

Lebar dasar rekahan (b), dianggap sama dengan lebar lembah sungai adalah 70 meter.

. Kemiringan sisi rekahan (z), merupakan karakteristik sudut geser dalam material longsoran dan diasumsi pada su-

dut geser dalam material bendungan yang berupa breksi yakni (h/v) = 0,73 (42°)
Waktu keruntuhan (7), dalam penelitian ini 7 tidak dilakukan analisis sensitivitas

Pemetaan Banjir dan Pengolahan Hidraulika

Keruntuhan bendungan menyebabkan terjadinya banjir bandang dan genangan pada daerah hilir bendungan.
Pemetaan banjir diselesaikan dalam GIS (Geographic Information Systems) menggunakan soffware Hee-GeoRAS. Informasi
GIS di ekspor dari Hec-Ras dan dibaca ke dalam GIS dengan GeoRAS. HEC-GeoRAS menghasilkan peta genangan
banjir untuk tingkat kedalaman. Data DTM yang digunakan pada peneliti ini adalah data TIN (I7iangulated Irregular
Network). Peta dasar yang digunakan dalam penelitian ini berupa data digital Rupa Bumi Indonesia (RBI)
Bakosurtanal skala 1:25000 dalam bentuk shapefile.

Langkah untuk memetakan banjir diuraikan sebagai berikut:

)

b)

d)

Mengkonversi TIN di .AreMap 9.3.1
1. Membuat data DEM dengan membuka ArnToolbox, klik 3D Analyst Tools = Raster Interpolation = Topo to Raster.
2. Mengkonversi data DEM menjadi kontur dengan interval kontur 2 meter dengan membuka ArToolbox;, klik
3D Analyst Tools =2 Raster Surface = Contour.
3. membuat data TIN dengan cara, pada toolbar 3D Analyst klik 3D Analyst => Create/ Modify TIN => Create TIN
[from Features.
Mengaktitkan Ekstensi Hee-GeoRAS 4.7.7
Lakukan dengan mengklik Customize =2 Toolbar 2> HEC-GeoRAS.
Membuat Layer RAS (Geospatial) Simulasi Sungai di AreMap
Layer RAS yang digunakan untuk membuat set geometris yang dimodelkan dalam HEC-RAS meliputi: Sungai
(Stream Centerline), bantaran sungai (Bank Lines), jarak tempuh aliran (Flow Path Centerline), tampang lintang (X§
Cut Lines), geometri bendungan (Inkine Structures), dan waduk (Storage Area).
Mengeksport Data GIS ke HEC-RAS 4.7.1
1. Memilih data yang akan dicksport dengan pilih RAS Geometry 2 Layer Setup = Required Layers tab.
2. Mengeksport data GIS dilakukan dengan pilih RAS Geometry 2 Export RAS Data.
Pengolahan Hidraulika di HEC-RAS 4.7.0
1. Masuk ke HEC-RAS, buat data kosong dan simpan. Kemudian lakukan szport data dari GIS ke HEC-
RAS dengan menu Edit > Geometric Data >pilih menu File > Import Geometry Data > GIS Format
2. Masukkan nilai n’'manning dengan klik Geometric Data = Tables menu = Manning’s n or k values
3.  Mengedit struktur bendungan, Klik editor In/ine Structure. Selanjutnya lakukan:
a.  Klik Weir/ Embankment untuk input parameter struktur bendungan
b. Klik breach (plan data) untuk memasukkan parameter keruntuhan bendungan
c. Klik Rules (unsteady data) untuk memasukkan data syarat batas dan kondisi awal.
4. Setting Running Simulasi (Perform Unsteady Flow Analysis)
5. Ekspor ke ArcGIS untuk melakukan deliniasi area genangan. untuk mengekspor klik Fik = Export GIS Data
2 Klik Export Data, file sdf akan muncul di directori ketja. Keluar dari HEC-RAS dan masuk ke ArcGIS.
Mengimport Data dari HEC-RAS 4.1.0
1. Kembali ke proyek sebelumnya di ArcMap dan impor data dati model hidrolika HEC-RAS, pada toolbar HEC-

GeoRAS, Klik tombol #%  Lpor RAS SDF Fil
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2. Klik pada RAS Mapping = Layer Setup untuk menganalisis genangan berdasarkan data HEC-RAS.

3. Klik RAS Mapping 2 Import RAS Data. Ini akan membuat poligon batas dengan menyambungkan titik
akhir dari XS Cut Lines.

g) Pemetaan Banjir menggunakan GIS

1. Klik RAS Mapping 2 Inundation Mapping = Water Surface Generation. Pilih Max WS sebagai profil dan klik
OK, hal tersebut akan membuat permukaan dengan elevasi permukaan air untuk profil yang dipilih.

2. Klik RAS Mapping 2 Inundation Mapping = Floodplain Delineation Using Rasters, pilih pada Max WS
sebelumnya. TIN yang tadi akan dikonversi ke GRID dan kemudian surface terrain di kurangkan dari grid
urface air. Hasil akhir adalah poligon genangan banjir, dan GRID yang merepresentasikan kedalaman air
seperti pada Gambar 4.

Keterangan:

= Poligon Shp genangan

= Elevasi permukaan air
maksimum yang berupa
dataTIN

= Profil sungai

@ = Bendungan

Gambar 4. Poligon Ge

Hasil Analisis Sensitivitas Debit Puncak Terhadap Parameter Keruntuhan

Pertumbuhan rekahan pada tubuh bendungan tergantung sifat-sifat material penyusunnya. Sifat tersebut dalam sgfhware
HEC-RAS 4.1.0 dikenal sebagai parameter keruntuhan seperti lebar dasar bukaan keruntuhan (b) bendungan pada
HEC-RAS digunakan untuk menguji sensitivitas antara parameter keruntuhan dan Qmax. Hasil analisis dirangkum da-
lam Tabel 1. Model ilustrasi skenario keruntuhan bendungan Pacal disajikan pada Gambar 5 dan Gambar 6.

Tabel 1. Perbandingan Debit Maksimum dan Parameter Keruntuhan

Skenatrio Parameter keruntuhan . .
Lebar dasar rekahan (m) Kemiringan sisi rekahan (1:z) Debit Maksimum (m?/s)
1 70 0,73 305821,9
2 70 0,37 305821,9
3 70 0,55 305821,9
4 70 1,1 305821,9
5 35 0,73 305821,9
6 52,5 0,73 305821,9
7 105 0,73 305821,9

Tabel 2. Presentase Perubahan Debit Maksimum dan Parameter Keruntuhan

Perbandingan Parameter keruntuhan (%) . . o
Skenario Lebar dasar rekahan Kemiringan sisi rekahan Debit Maksimum (%)
1dan2 0 -49,32 0,00
1dan 3 0 -24,66 0,00
1 dan 4 0 50,68 0,00
1dan5 -50 0,00 0,00
1dan 6 -25 0,00 0,00
1dan7 50 0,00 0,00
BENDUNGAN BENDUNGAN

Rekahan (breach) Rekahan (breach)

35 35

267.15 267.15

Gambar 5. Hustrasi Skenario Keruntuhan 1,2,3, dan 4 Gambar 6. Hustrasi Skenario Keruntuhan 5,6, dan 7.
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Tabel 1 dan Tabel 2 dapat dijelaskan hal-hal sebagai berikut:

1. Pada kondisi b tetap, perubahan pengurangan z sampai dengan 49,32% dan peningkatan sampai 50,68%
mengakibatkan perubahan debit puncak banjir yang dihasilkan tetap/tidak ada perubahan. Dari hasil pet-
bandingan ini disimpulkan bahwa debit puncak banjir hidrograf outflow yang dihasilkan tidak sensitive terha-
dap perubahan kemiringan lereng rekahan keruntuhan (z).

2. Pada kondisi z tetap, perubahan pengurangan b sampai dengan 50% dan peningkatan sampai 50%. Dari ha-
sil perbandingan ini disimpulkan bahwa debit puncak banjir hidrograf outflow yang dihasilkan tidak sensitive
terhadap perubahan lebar rekahan keruntuhan (b).

3. Dari kedua kesimpulan tersebut dapat disimpulkan bahwa perubahan perameter b dan z tidak
mengakibatkan perubahan pada debit puncak banjir hidrograt outflow yang dihasilkan, sehingga skenario
tersebut tidak sensitive. Debit maksimum pada setiap skenario terjadi pada stationing sungai yang sama yaitu
39+166,59. Ini terjadi karena data topograti RBI Bakosurtanal dalam menginterval kontur pada daerah
sungai kurang sempurna serta tidak adanya ketersediaan data pengukuran.

Hasil Analisis Sensitivitas Debit Puncak Terhadap Koefisien n’Manning

Dalam simulasi penelusuran aliran wnsteady, hasilnya sangat sensitif terhadap nilai n manning karena salah satu parame-
ter fisik model yang tidak pasti. Dalam kasus ini n manning dianggap tetap untuk sepanjang sungai dan elevasi air yang
berbeda dan diasumsikan sama untuk kiti saluran, kanan saluran dan saluran utama, karena sulitnya menentukan koefi-
sien n manning yang disebabkan oleh banyaknya faktor yang mempengaruhi. Dalam analisis ini tinjauan dilakukan di
hilir bendungan.

Pada analisis sensitivitas ini, untuk hulu bendungan ditetapkan nilai n manning adalah 0,15 dan di hilir digunakan 5 va-
riasi nilai n manning bendungan yaitu 0,02 dan 0,03; 0,03 dan 0,04; 0,03 dan 0,045; 0,035 dan 0,04; 0,035 dan 0,045.
Hasil perbandingan 5 variasi tersebut mengakibatkan debit puncak banjir hidrograf outflow yang dihasilkan sensitive.
Hasil perbandingan 5 variasi koefisien n manning mengalami peningkatan sampai 434,25% (0,02 -0,03 dan 0,03 -0,045)
schingga mengakibatkan debit puncak banjir hidrograf oufflow yang dihasilkan sensitive. Hal ini kemungkinan
disebabkan oleh ketidakserasian antara data sebenarnya dengan data topografi RBI Bakosurtanal disertai pula
ketidaksempurnanya interval pada kontur sungai dalam menggambarkan tampang lintang sungai.

Penelusuran Banjir Hasil Simulasi
Simulasi aliran banjir akibat keruntuhan bendungan menelusuti sungai kalipacal kearah hilir hingga batas simulasi. Dari
hasil simulasi, ujung banjir mencapai km 39,578 (RS 0+340) dalam waktu keruntuhan 0,15 jam (9 menit) yakni pada
pukul 00:01 sejak mulai terjadi keruntuhan, sedangkan puncak banjir terjadi pada pukul 04:23 atau dalam waktu 4,37
jam (262 menit) dengan debit puncak 1033,81 m?/s dan tinggi muka air maksimum 0,82 meter dari dasar sungai.
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Gambar 5. Elevasi Muka Air Banjir Maksimum Hasil Simulasi
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Gambar 6. Debit Puncak Banjir Hasil Simulasi
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Gambar 7. Kecepatan Banjir Maksimum Hasil Simulasi
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Gambar 5, Gambar 6, dan Gambar 7 dapat dijelaskan hal-hal sebagai berikut:

1. Gambar 5 mengalami penurunan elevasi muka air banjir maksimum, hal ini disebabkan oleh penurunan elevasi
dasar sungai yang sedikit drastis dan kecepatan banjir yang meningkat.

2. Gambar 6 mengalami penurunan debit puncak banjir yang besar, hal ini disebabkan oleh efek tampungan pada
bantaran sungai, dan adanya gesekan pada bagian dasar dan tebing sungai. Debit puncak mengalami peningkatan
disebabkan oleh perubahan tampang lintang yang cukup besar dengan kemiringan sisi tebing sungai yang semakin
melebar disertal tampang sungai yang berkelok tajam.

3. Gambar 7 mengalami penurunan dan peningkatan kecepatan banjir disebabkan oleh efek sungai yang berkelok
tajam disertai pengaruh jarak tempuh aliran pada bantaran sungai.

Daerah Tergenang

Penyusunan peta genangan berdasarkan administrasi daerah yang tergenang (desa dan kecamatan), jarak dari
bendungan (L), tinggi genangan (H), luas genangan (A), dan volume genangan (V). Berdasarkan hasil analisis
daerah yang terkena resiko banjir paling tingei adalah desa Sukosewu, kecamatan Kapas. Sedangkan daerah yang
terkena resiko dengan volume yang paling besar adalah desa Temayang, kecamatan Temayang. Hasil tersebut
menunjukkan tinggi, luas, dan volume genangan yang tidak linier disebabkan efek elevasi dasar sungai.

SIMPULAN

Dari proses analisis terhadap parameter keruntuhan dan pengujian sensitivitas diperoleh kesimpulan sebagai berikut:

1. Kemungkinan genangan akibat keruntuhan bendungan yaitu menuju hilir bendungan ke sungai kalipacal sepanjang
40 km. Berdasarkan hasil analisis daerah yang terkena resiko banjir paling tinggi adalah desa Sukosewu,
kecamatan Kapas. Sedangkan daerah yang terkena resiko dengan volume yang paling besar adalah desa
Temayang, kecamatan Temayang. Hasil tersebut menunjukkan tinggi, luas, dan volume genangan yang tidak
linier disebabkan efek elevasi dasar sungai.

2. Simulasi pemodelan banjir dilakukan menggunakan sgfware HEC-RAS 4.1.0. Hidrograf banjir diperoleh dengan
menganalisis aspek hidrologi terkait. Hasil simulasi hidrologi dam break antara lain: analisis hujan maksimum harian
rerata daerah dilakukan dengan metode Polygon Thiessen. Hasil uji agihan frekuensi yang memenuhi syarat yaitu
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Metode Log Pearson Type 1II. PMP DAS Pacal sebesar 518,179 mm. Debit banjir rancangan yang memenuhi
kritetia pada grafik Creager adalah metode Hidrograf Satuan Sintetik (HSS) Nakayasu sebesar 2047,71 m3/dt.

3. Hidraulika akibat daw break antara lain dilakukan analisis penelusuran aliran puncak banjir dengan aliran #nsteady
disimulasi dengan sofivare HEC-RAS 4.1. Terkait dengan keterbatasan data dan informasi yang diperoleh, data
tampang lintang di hilir bendungan sungai diinterpretasikan dari peta topografi Rupa Bumi Indonesia (RBI)
Bakosurtanal skala 1:25000 tahun 2001. Pemodelan simulasi sungai dilakukan di HEC-GeoRAS tetlebih dahulu
kemudian diinterpretasikan ke dalam HEC-RAS.

4. Debit puncak banjir (Qoutflow) yang dihasilkan oleh keruntuhan bendungan tidak sensitive terhadap perubahan pa-
rameter keruntuhan (b dan z) dan sensitive terhadap variasi koefisien n manning.

5. Aliran banjir yang mengalir kearah hilir mengalami penurunan elevasi muka air banjir maksimum, hal ini
disebabkan oleh penurunan elevasi dasar sungai yang sedikit drastis dan kecepatan banjir yang meningkat.

6. Aliran banjir yang mengalir kearah hilir mengalami penurunan debit puncak banjir yang besar, hal ini disebabkan
oleh efek tampungan pada bantaran sungai, adanya gesekan pada bagian dasar dan tebing sungai. Debit puncak
juga mengalami peningkatan yang disebabkan oleh perubahan tampang lintang yang cukup besar dengan kemirin-
gan sisi tebing sungai yang semakin melebar.

7. Aliran banjir yang mengalir kearah hilir mengalami penurunan dan peningkatan kecepatan banjir disebabkan oleh
efek sungai yang berkelok tajam disertai pengaruh jarak tempuh aliran pada bantaran sungai.

8. Penulis menyadari bahwa penelitian ini banyak digunakan asumsi dan mengikuti data yang ada yaitu data topografi
RBI Bakosurtanal dalam melakukan simulasi karena keterbatasan data dan informasi yang terukur. Simulasi
penelitian ini dapat dikatakan tidak sempurna, karena ketidaksesuaian pada data teknis bendungan Pacal dan data
topografi RBI Bakosurtanal. Hambatan pada data topografi adalah keterbatasan interval kontur pada peta digital
RBI Bakosurtanal. Namun hasil akhir menunjukkan bahwa bendungan Pacal mengalami keruntuhan overopping.

REKOMENDASI

Rekomendasi yang dapat kami berikan untuk menindaklanjuti hasil penelitian adalah:

1. Sebaiknya data untuk simulasi di HEC-RAS dan HEC-GeoRAS sesuai dengan data lapangan yang ditinjau.

2. Dalam mengkonversi data DEM menjadi data TIN harus teliti dalam pengecekan kontur dan garis sungai.

3. Sebaiknya juga memperhitungkan transpor sedimen schingga diperoleh hasil yang lebih efektif dalam pendekatan
kejadian keruntuhan bendungan.

4. Sebaiknya saat mensimulasi tampang lintang sungai di Hec-RAS, jarak per station dibuat lebih detail agar
mendapatkan hasil yang lebih efisien dalam pendekatan simulasi keruntuhan bendungan.

5. Perlu penelitian lanjutan dengan data dan informasi yang lebih terukur sehingga hasil simulasi lebih efektif dan
mendekati kondisi lapangan yang sebenarnya.
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